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Exercise 1: Creating a shapefile based network dataset

In this Exercise you will create a simple shapefile based network dataset
from a single line feature class and a turn feature class.

Creating a network dataset
1. Start ArcCatalog by either double-clicking a shortcut installed on
your desktop or using the programs list in your Start menu.

2. Navigate to the C:\arcgis\ArcTutor\Network Analyst folder in the
Catalog Tree. (This is the default install location for this data.)

3. Click the Exercisel folder to show its contents.
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4. If the Network Analyst Extension is not enabled, on the Tools menu,
click Extensions, and in the Extensions dialog, click Network Analyst
and close the Extensions dialog.

5. Right-click the Streets shapefile and choose New Network Dataset.
This shapefile contains street data for downtown San Francisco.
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6. The name of the network dataset is set to Streets ND by default.

Click Next to continue. [T S 2l

This wizard will help you build a netwerk dataset & natwork dataset is built from feature
clasves which act as network sources and have a connectivity policy and attributes:
associated with them

Entex a name for yout network dataset
|sneets,ND\
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Network Connectivity defines how features that participate in a
network connect to each other. The default connectivity for a network
dataset places all sources in one connectivity group and assigns all
edge sources endpoint connectivity. In a shapefile based network
there is only one edge source, hence there is no need for multiple
connectivity groups. Also, we wish to model streets with endpoint
connectivity. (To see how this is modeled, you may click the
Connectivity button.)

You will accept the default connectivity, therefore Click Next to
continue.
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Earlier versions of ArcView GIS and ARC/INFO support optional
elevation fields to establish connectivity. Each feature in a shapefile
or a coverage would be assigned two Z-elevation values, one for each
endpoint. If the endpoints of line features have the same Z-elevation
value, connectivity is established. If the values are different, they do
not connect (e.g. in the case of bridges or tunnels).

The elevation field contains logical elevation values for establishing
connectivity only and does not provide height information for

the feature. ArcGIS Network Analyst can use this data to modify

the connectivity settings established in the previous step. ArcGIS
Network Analyst automatically searches and maps the relevant fields.

Click Next to accept the default elevation fields settings. If ArcGIS
Network Analyst finds elevation fields data in your shapefile,

it automatically chooses the Yes radio button and assigns the
appropriate fields.



New Network Dataset i d B
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Click in the Field column to set elevation fields.
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ArcGIS Network Analyst supports turns in a shapefile based network.
Turn information (such as turning restrictions and delays) enhance
the quality of network analysis. Earlier versions of ARC/INFO and
ArcView GIS used turn tables. These turn tables can be converted
into turn features and used in the network dataset. You will use turn

features in Exercise 2.

In addition, by default Global Turns are selected. Global Turns are

rules that can be set, such as all left turns have

a delay of 15 seconds.

Such a rule gives preference to right turning movements. The
advantage of Global Turns is that you do not need to create individual
turn features for rules that apply to every turn in the network.

9. Click Yes to model turns in the network.
10. Click Next to continue.
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Network attributes are properties of the network that are used to
control navigation. Common examples are costs that function as

11.

12.

impedances over the network. Restrictions like oneway traversal are
also examples of network attributes.

The ArcGIS Network Analyst analyzes the source shapefile and

looks for common fields like Meters, Minutes (FT Minutes and

TF_ Minutes, one for each direction), and Oneway. Once it finds these
fields, it automatically creates the corresponding network attributes
and assigns the respective fields to them. (This can be viewed by
clicking the Evaluators button.)

Since the attributes are automatically defined and assigned values,
click Next to continue.
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To use driving directions in a network analysis, they should be set
in the network dataset.

Select Yes to establish driving directions settings for this network
dataset.

The Network Analyst automatically finds and maps the field in the
streets source that will be used to report street names. Additionally
Length and Time fields are automatically mapped as well.



13. Click Next to continue.

New Network Dataset 2

Do you want to establish diving directions seftings for this network dataset?
 No

Al directions settings can be changed now or after the netwark has been created.
Click the Directions...'butten to change the default directions settings
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14. A summary of all the settings that have been chosen is displayed in
the following window for your review.

Click Finish to create the new shapefile based network dataset.

New Network Dataset . 2] x]|

Summary:
Name: Streets_ND -
(Type: Shapefile-Based Network Dataset

Sources:
Edge Sources:
Streets

Group 1-

Edge Connectivity:
Strests (End Poirt)

Flevation Fields:

Edge Blevation Fislds: (From End, To End):
Strests: {F_ZLEV, T_ZLEV)
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Once created, the system prompts for the network to be built.
15. Click Yes to build the network.
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The new network datsset has been created. Wolild you like to build it now?

The network dataset has been built when the progress bar disappears.

=
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The shapefile based network, Streets ND, is added to ArcCatalog
along with the system junctions shapefile Streets ND Junctions.

Select Streets ND and click on the Preview tab to see the built
network dataset.
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17. Close ArcCatalog.




Exercise 2: Creating a geodatabase network dataset

In this Exercise you will create a geodatabase based network dataset 8. Click Next.
using the streets feature class for Paris. 9. Check the Streets feature class to use it as a source for the network
. dataset.
Creating a network dataset OIS el
1. Start ArcCatalog by either double-clicking a shortcut installed on e e e e B R e
your desktop or using the programs list in your Start menu.
. . A=l strests Select Al
If the Network Analyst Extension is not enabled, on the Tools menu, & e
click Extensions, and in the Extensions dialog, click Network Analyst
and close the Extensions dialog.
2. Navigate to the C:\arcgis\ArcTutor\Network Analyst folder in the
Catalog Tree. (This is the default install location for this data.)
Double-click the Exercise2 folder to expand it.
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4. Click the plus sign on Paris.gdb. This will expand the connection tree
to show you the contents of the geodatabase. )
. . ) . 10. Click Next.
5. Click the RoadNetwork feature dataset. The contents will be listed in ] o o
the Contents tab. 11. Click Connectivity to set up the connectivity model for the network.
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6. Right-click the RoadNetwork feature dataset, click New, then click _
Network Dataset. This will open the New Network Dataset Wizard. ;h;:m_mm;;m’ﬁr 1]
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7. Type “ParisNet” as a name for your network dataset.
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The Streets feature class has three subtypes that we wish to use to set
s up the connectivity - Highways, Major Roads and Local Streets.

12. Click the Subtypes button to bring up the Connectivity Settings:
Subtypes Dialog. Check the Box next to Streets (3) to use the three
subtypes of Streets.
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15.
16.
17.

Ml Connectivity Settings : Subtypes |

The connectivity settings for each element in an =dge or junclion feature source can
sither be the same or vary by sublyps

Select the sources that shauld have distinct connsctivity settings for each sublyps

| Subtype Names |
Highways, Major Roads, Local Streets

Streets (3)

Cancel

Click OK to return to the Connectivity dialog. There are now three
rows, one for each subtype.

Comnectivity Graups
Source | Connectivity Policy | 1 [
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Streets : Major Roads End Paint
Streets : Local Streets End Point

Group Colurns: |_1:|| oK Cancel

For this network, Highways and Major Roads connect to each other
at end points. Local Streets connect at any vertex of geometric
coincidence. Change the connectivity policy of Streets: Local Streets
to Any Vertex.

Source Connectivity Polngz 1
Streets : Highways End Paint
Streets : Major Roads End Paint
Streets : Local Streets -

Click OK to close the Connectivity Group dialog box.
Click Next.

There is no elevation field data for this dataset, therefore make sure
No is selected.

Elevation fields have been used since the earlier versions of ARC/
INFO and ArcView GIS to model connectivity. ArcGIS Network
Analyst supports this connectivity model. Each feature in a shapefile

or a coverage would be assigned two Z-elevation values, one for each
endpoint. If the endpoints of line features have the same Z-elevation
value, connectivity is established. If the values are different, they

do not connect (e.g. in the case of bridges or tunnels). The elevation
field contains logical elevation values for establishing connectivity
only and does not provide height information for the feature.

18. Click Next.
19. Select Yes for modeling turns in the network. Check the box by
ParisTurns to select the turn feature source.
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20. Click Next.

21. There are three attributes that are added by default, Oneway, Minutes
and Meters. o — 7]
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ArcGIS Network Analyst inspects all sources and tries to
automatically assign values for these three attributes.

22. Click Evaluators to inspect the evaluator assigned by source for each
attribute. Select each attribute from the pull down menu and inspect
the type and value assigned to it.
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Click OK to return to the New Network Dataset Wizard.

You will add a new attribute that will restrict movement over the
turn elements created from ParisTurns. Click Add to bring up the
Add New Attribute dialog. Type TurnRestriction as the name of the
attribute and select Restriction as the Usage type. Note that the Use
by Default option is checked. This restriction will be used by default
when a new network analysis layer is created. If checked here, it can
be disabled during analysis.
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25. Click OK. A new attribute called TurnRestriction is added to the list.
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Click Evaluators to assign values by source.

Set the Type of Evaluator for ParisTurns to Constant by clicking in
the Type column, for the ParisTurns row and selecting Constant from
the dropdown box.
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28. Change the Value for ParisTurns to Restricted. The evaluators for
other sources are set automatically to Traversable under Default
Values.
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29. Click OK to return to the New Network Dataset Wizard.
30. Click Next to continue.

31. Click Yes to set up directions. Click Directions to open the Network
Directions Properties Page. Here, you will set up the fields used to
report directions after network analysis.

32. In the General tab, click under the Name column for the Primary row



and select FULL NAME from the dropdown list. In the Paris streets
data, this field contains the street names that will be used to generate

directions. ParisNet Junctions. Preview the network dataset by selecting it and
clicking on Preview.
S aomy| S 37. Close ArcCatalog.
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Display Length Units Miles
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Once the network dataset is built, you should see a new network
dataset called ParisNet along with the system junctions feature class
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33. Click OK to return to the New Network Dataset Wizard.

34. Click Next to see a summary of the settings defined.
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Summary:

Sources: =l
Edge Sources J

Strests

(Connectivity:
Group 1:
Edge Connectivity:
Strees - Highways (End Poirt)
Streets - Local Streets (Any Vertex)
Sireets - Major Reads (End Peint)

Tums:

<Global Tums>
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35. Click Finish to create the new network dataset.

36. Click Yes to build the network dataset.
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Building the netwerk dataset...
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Exercise 3: Creating a multimodal network dataset

In this Exercise you will create a multimodal network dataset from
multiple feature classes within a feature dataset in a geodatabase.

Creating a network dataset

1.

Start ArcCatalog by either double-clicking a shortcut installed on
your desktop or using the programs list in your Start menu.

If the Network Analyst Extension is not enabled, on the Tools menu,
click Extensions, and in the Extensions dialog, click Network Analyst
and then close the Extension dialog.

Navigate to the C:\arcgis\ArcTutor\Network Analyst\Exercise3
folder in the Catalog Tree. (This is the default install location for this
data.)

Double-click the Exercise3 folder to expand it.

Click the plus sign on Paris.gdb. This will expand the connection tree
to show you the contents of the geodatabase.

Click the Multimodal Network feature dataset. The contents will be
listed in the Contents tab.

Right-click the Multimodal Network feature dataset, click New, then
click Network Dataset. This will open the New Network Dataset
Wizard.
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7.  Type “ParisMultiNet” as a name for your network dataset.

New Network Dataset - HE

This wizard wil help you build a network dataset. Anetwork dataset is buit from feature
classes which act as network sources and have a connectivity policy and attributes
associated with them.

Ertter a name for your network dataset:
ParisMultiMet]

< Back Next > Cancel

Click Next.

9. Click Select All to select all the feature classes to participate as

sources in the network.
o networic s

Metwork datasets are comprsed of network sources. Each sourcs comesponds to 3
feature class that has been added to the network dataset, edge sources ta line feature
classes and junetion sources to point festure classes.

Metro_Lines Select Al
Transfer_Stations Clear All
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Metre_Entrances
AE Metro_stations

(Bad(lNa‘i>ICa'lcd

10. Click Next.
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11. Click Connectivity to set up the connectivity model for the network.
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Click the Group Column up-arrow once, to increase the number of
connectivity groups to 2. Connectivity group 1 represents the metro
system and connectivity group 2 represents the street network.

Group Calumns: I B ﬁ

Check the boxes under the Connectivity Group numbers to assign
each source to the group they belong to. Click under the column
labeled 2 for the Streets row to move Streets to connectivity group 2,
as shown in the graphic below. Click under the column labeled 2 for
the Metro Entrances row to assign Metro Entrances to both groups 1
and 2. They are the points of transfers between the two networks.

Conneclivity Groups
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End Paint
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Click under the Connectivity Policy column for Metro Entrances and
select Override from the dropdown list.

Each feature of Metro Entrances is coincident with a vertex of the
streets feature class. However the streets feature class has a policy
of endpoint connectivity. Since the Metro Entrances are to be
connected to the streets at the coincident vertex, you have set the
Metro Entrances to override the default endpoint connectivity of the
streets.

15.
16.
17.

18.
19.

20.
21.
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Metro_Entrances
Metro_Stations

Override

Click OK to close the Connectivity Gro dialog box.
Click Next.

There is no elevation field data for this dataset, therefore be sure No
is selected.

Elevation fields have been used since the earlier versions of ARC/
INFO and ArcView GIS to model connectivity. ArcGIS Network
Analyst supports this connectivity model. Each feature in a shapefile
or a coverage would be assigned two Z-elevation values, one for each
endpoints. If the endpoints of line features have the same Z-elevation
value, connectivity is established. If the values are different, they
do not connect (e.g. in the case of bridges or tunnels). The elevation
field contains logical elevation values for establishing connectivity
only and does not provide height information for the feature.

Do you need to modfy the connectivity with elevation field data?

),

" Yes

Click Next.

Select Yes for modeling turns in the network. Although you have no
turn feature classes for this network, selecting yes allows the network
dataset to support global turns. Turn information can be added to an
existing network dataset, if it supports turns. If you choose no here,
you will not be able to add turns to this network on a later date.

Do you want to model tums in this network ?

" No
Mgl [%
Click Next. T
There are three attributes that are added by default, Oneway, Minutes

and Meters.

New Network Dataset I 2 x|
Specity the atfributes for the netork dataset Add
| Usage | Urits | Data Type |
Cost Meters Couble Remave
Cost MinLites
& Orewiay Resfriction  Urknown  Boolean Femove All

RoadClass Descriptor  Urknown  Integer

Since this is a multimodal network you will add different time
attributes based on mode. For automobiles, you will have an attribute
called Drivetime and for pedestrians, you shall have a Pedestrian
Time attribute.



22.

23.

24.

The attribute Minutes is added by the Network Analyst by default.
We can rename this attribute to be called Drivetime.

Select the Minutes row, click Rename, then type “Drivetime”.

RoadClass

New Network Dataset ilil
Specify the atributes for the netwark dataset Add..
| Usage | Urits | Data Type |
Cost Meters Double Remove
Cost Minutes Double
@ Oneway Resfriction  Unknown Boolean Remove All

Descriptor— Unknown  Integer

The Meters and Drivetime attributes have a yellow warning symbol
that represents a potential problem with the evaluators.

Select Meters and click Evaluators to inspect values for the Meters
attribute for each source in the network.
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ArcGIS Network Analyst inspects all sources and tries to
automatically assign values for the Meters attribute. The Metro
Lines source and the Streets source have a field called Meters,
therefore this field is automatically assigned to the sources.

For each edge source in the network, attributes need to be assigned
for each direction of travel. Since the length does not depend on
direction of travel, the same values are assigned for both directions
of a source. Network Analyst attempts to assign values for each cost
attribute for each edge source that participates in the network. In
this case, Network Analyst was unable to find values for Transfer
Stations and Transfer Street Station sources. Hence a warning
symbol is present to indicate that there is a problem.

Select all four rows with the yellow warning symbol (two sources
in both directions), right-click, choose Type, and click Field. The
yellow warning sign changes to a red exclamation mark indicating an

incomplete assignment of values.

Seuaca Vihome | ks Vs |

25. The four rows, now with the red exclamation mark, should still
be selected. Right-click the selected rows, choose Value and click
SHAPE LENGTH. This will assign values for the Meters attribute
for the selected sources from the their SHAPE LENGTH field.

Matrg_Entrances Aretion
Wetra_Statiore Jnctin

26. Click Apply.

27. From the Attributes dropdown box, select Oneway. The attribute
Oneway has been assigned values automatically by the ArcGIS
Network Analyst for the Streets source. Since all other sources are
related to the metro system, they have no oneway restrictions.

28. From the Attributes dropdown box, select Drivetime.

The values for the street network are populated automatically by
Network Analyst. Other edge sources have no values assigned and
have the warning symbol.

The attribute Drivetime will be used to model the travel time using
automobiles. Since automobiles travel on streets only (and not
on Metro_Lines or transfers between stations), a valid value of

Drivetime can exist only for streets (which has been automatically set

up).
29. Select all the other edge sources that belong to the metro system

11
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30.

31.
32.
33.

34.
35.

(Metro_Lines, Transfer Station, and Transfer Street Station). You
can use the CTRL key and select each of them. Click on the column
heading named Type and select Constant.

The same rows should still be selected. Hit the F12 key on the
keyboard to bring up the Constant Value Input box. (Alternately,
you can also right-click the selected rows, point to Value and select
Properties to bring up the same input box.) Type -1 and press Enter.

By assigning a constant of -1, the system will treat the sources as
restricted when the attribute Drivetime is used as an impedance.
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Click OK to return to the New Network Dataset Wizard.
Click Add to add a new attribute.

In the Add New Attribute dialog box, enter “Pedestrian_Time” for
the Name. Set the Usage Type as Cost, the Units as Minutes and the

Data Type as Double.
Al New Artribute = _‘Uﬂ
M ﬁr-ﬁﬁ‘jme oK I

uegeTy [con =] _ Gl |
we T -

OeeTipe  foowsa =]
1™ Lne b Cimtmud
Click OK.
Select Pedestrian_Time and click Evaluators.

The Pedestrian_Time attribute in the network represents the time a
pedestrian takes on the network. In this case it has two components
because a pedestrian can utilize the metro system in addition

to walking on the street network. In the Evaluators dialog, the
following six sources should already be selected. Metro_Lines (in
each directions), Transfer Stations (in each direction) and Transfer
Street_Station (in each direction). If not, you can use the CTRL key
and select each of them.

Attribute: W

- Attiibute Yalues:

Sounce Values | Default Values |

FT_MINUTES
TF_MINUTES

EYES

Junction
Junction

Metro_Entances
Metro_Stations

0K I Cancel Apply

36. Right-click, choose Type, and click Field.

FT_MINUTES
TF_MINUTES

Junction
Junction

37. The same rows should still be selected. Right-click, choose Value,
and click TRANSITTIM.

1| Searce

Matra_Ertrances:
Hatro_Statee




38.

39.

40.

To set up the Pedestrian_Time for Streets, click the row for Streets
in the From-To direction. Hold the CTRL key and click the row for
Streets in the To-From direction, to select both rows for the Streets
source.

Right-click on the selected sources, point to Value, and click
Properties to bring up the Field Evaluators dialog box.

1] Soirce | Drecton [ Emert [ Typ= [ [
t Matro_Lines Fram-Teo Edge Fild <rul=
E Matro Line To-From E

E Trarefor_Sta0oms

P Trarefor_Stadons To-From Eciga

P Trarefr_Sirest_Saton Fram-To Edga

P Trarefor_Sirast_Station To-From Eciga
Mamo_Entrances: reton

WatTa_STators unetion

On the street network a pedestrian can walk. Hence for the streets
source, the value of Pedestrian Time is the walk time for a
pedestrian. Assuming that a pedestrian walks at 3 km/h, walk time
in minutes will then be [Meters] * 60 / 3000 where [Meters] is the
attribute containing length of the edge in meters.

Click on METERS field to move it into the “Value =" location and
finish typing the expression as [METERS] * 60 / 3000 in the Field
Evaluators Dialog as shown below. Click Verify to verify that the
expression is correct. Fix if necessary.

Fields Type Functions
CrCC Al & Mumber
DISP_CODE
FT_MINUTES £ Stiing
FULL_NAHE
FUNC_CLASS € Date
Hierarchy
METERS
Ni_Hierare =

Pre-Lagic VB Seript Code

El

Walue =

[METERS] ~ 60/ 3000 Y

41.
42.
43.
44.

45.

46.
47.

48.
49.

Click OK to close the dialog and to return to the Evaluators dialog.
Click OK to save the attribute assignment.
Click Next.

Click Yes to set up directions. Click Directions to open the Directions
Properties Page.

On the General tab, click the Source dropdown arrow and click
Streets. kil

[Meetwark Directions Properties
Generm! | Shinkda | Beairory |
Directions Sethirgs
Dy Lergth Lk =

i
{ KR —

Frmet Har Fiek:

L ] oo
Click on Primary in the Street Name Fields list.

Click under the Name field and click FULL NAME from the
dropdown list.

Seurce Ism-m vI
Rank | Pretic | PrefuType | Mame | SuffaType | S
pinay FiLwe=]
_R"I:C_.CLJ\ES
Click OK.
Click Next to see a summary of the settings defined.
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50. Click Finish to create the new network dataset.

New Network Dataset
Creating new network dataset .
T T T Carcel |

51. Click Yes to build the network dataset.

Cancel

Once the network dataset is built, you should see a new network
dataset called ParisMultiNet along with the system junctions feature
class ParisMultiNet Junctions. Preview the network dataset by
selecting it and clicking on Preview.

Carteets Preves, | sesncen |

52. Close ArcCatalog.




Exercise 4: Finding the best route using a network dataset

In this Exercise you will find the best route for the given order of stops
based on travel time.

Preparing your display

If you have Exercise4.mxd open in ArcMap, skip steps 2 to 5.

2. Start ArcMap by either double-clicking a shortcut installed on your
desktop or using the programs list in your Start menu. Choose Ok to
start ArcMap with a new empty map.

Click File on the Main menu and click Open.

4. In the Open dialog box, navigate to C:\arcgis\ArcTutor\Network
Analyst\Exercise4. (This is the default install location for this data.)

Double-click Exercise4.mxd.

If the Network Analyst Extension is not enabled, on the Tools menu,
click Extensions, and in the Extensions dialog, click Network Analyst
and then close the dialog.

7. If the Network Analyst toolbar is not already present, on the Main
menu, click View, point to Toolbars, and click Network Analyst.

Network Analyst H

Netwerk anayst » [[ER [ -5 0 B 7 | Metwork Dataset [sveets nd | s

8. If the Network Analyst Window is not already F
open, click the Network Analyst Window button |
g8 on the Network Analyst toolbar.

This is a dockable window which you can dock
within the ArcMap window or leave undocked.
In this Exercise the window is docked below the
Table of Contents.

Creating the Route analysis layer

1. On the Network Analyst toolbar, click the Network Analyst
dropdown menu and click New Route.

The Network Analyst Window now contains [route =

empty lists of Stops, Routes and Barriers Stops (0)

categories. G

Additionally, the table of contents contains anew

Route Analysis Layer. =8 ;.,:.m

| =

Adding a stop | e
Next, you will add the stops between which you will be guu-«
creating the best route. L e

1.
2.

Click Stops(0) on the Network Analyst Window.
On the Network Analyst Toolbar, click the Create Network Location

tool .

Click anywhere on the street network in the map to define a new stop
location.

The program then calculates the nearest network location and
symbolizes the stop with the located symbol. The stop will remain
selected until another stop is placed or until it is unselected.

I e e

The located stop also displays the number 1. The number =R
represents the order in which the stops will be visited by the
calculated route.

You will also notice that the Stops category on the Network Analyst
Window now lists 1 stop. Expand the Stops category to see the
Graphic Pick 1 listed there. [ B

=]

Routes (0)
Barriers (0)

Add two more stops on the map. The stops are numbered 2 and 3.
The order of stops can be changed on the Network Analyst Window.

15
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The first stop is treated as the origin and the last, as the destination.

Foute i

If a stop is not located on the network, it will appear with an unlocated
symbol.

An unlocated stop can be located on the network by moving it, closer to
any edge that belongs to the network. On the Network Analyst Toolbar,
click Select/Move Network Location tool [ .

Using the Select/Move Network Location tool [ , click and drag the
unlocated stop closer to an edge on the network.

"© ;
P |
-

Setting up the parameters for the analysis

Next, you will specify that your route will be calculated based on time
(minutes), that U-turns are allowed everywhere, and that one-way
restrictions must be followed.

1. Click the Analysis Layer Properties button next to Route layer on the
Network Analyst Window to bring up the Layer Properties dialog for

Route.

 Hetwork Analyst Window S|

Route =
Stops (3)

Routes (D)

Barriers (0)

In the Layer Properties dialog, click the Analysis Settings tab. Make
sure the impedance selected is Minutes (Minutes).

Do not use time windows. (Leave the box unchecked). Time
windows are used when certain stops can only be visited at certain
times.

Do not reorder stops. (Leave the box unchecked). This preserves the
order of stops as decided by you, when you created the stops.

Choose Everywhere from the Allow U-turns dropdown box.
Choose True Shape from the Output Shape Type dropdown box.
Check the box labeled Ignore Invalid Locations. This will let you

find the best route using located stops. Stops that were not located on
the network will be ignored.

Check Oneway in the Restrictions list.

Gamened | Groug | Sowce Anaksis Baings | Accumuletion | Habrk Locet o | [Heie]
~Samngk j | et
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9. Check the Directions settings.

10. Make sure the Distance Units are set to Miles, the Use Time Attribute
box is checked and the time attribute is set to Minutes.



11. Click OK. 5. Close the Directions Window.

Run the process to compute the best route Adding a barrier
1. Click the Solve button ﬁ on the Network Analyst toolbar. In this section, you will add a barrier on the route, that represents a road
The route polyline appears in the map and in the Route category of E}ocllz and will find an alternate route to the destination, avoiding the road
the Network Analyst Window. OcK.
[ 1. Inthe Window menu, click Magnifier to bring up the Magnifier
window.

2. Click on the title bar of the Magnifier window and drag to reposition
the Magnifier window.

3. Move the Magnifier window over the route, to a point where you
want to add a barrier. The Magnifier window shows a part of the map
where you can add a barrier at a zoom of 400%.

2. Click the plus (+) sign next to Routes on the Network Analyst
Window to show the Route. 1

3. Right-click the new route called ‘Graphic Pick 1 - Graphic Pick 3’ i —
and click Directions Window to display driving directions. S [ e

= B

Barriers (0)
4. On the Network Analyst Window, click Barrier (0).
5.  On the Network Analyst Toolbar, click the Create Network Location
4. The Directions Window can also be displayed with turn-by-turn maps tool K. .
that can be shown by clicking on the Map link.
T — -l
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6.

8.

In the Magnifier Window, click anywhere on the route, to place a
barrier.

Click the Solve button ﬁ on the Network Analyst toolbar. A new
alternative route is computed, avoiding the barrier.

Magnification: 400% [Live]
fo———— r—

ESE
T
e i e

Close the Magnifier Window.

Saving the best route

1.

Right-click Routes (1) on the Network Analyst Window and click
Export Data.

[Route =l =
Stops (2)
=

emmiGraphic | & Cat

5 Barriers (10 cony

¢ X Delete

E Paste

] Open Attrbute Table

@ ZoomTo Layer
Selection

Load Locations. .,

ﬂ Relocate Selected Locations

[ oo, |

] pelerz al

s

Type in a location and shapefile name to save the results such as
C:\Data\Exercise4 Route.shp in the Output shapefile or feature class
field.

Click OK. The best route generated is saved to the specified
shapefile.

Click NO when prompted to add the exported data to the map as a
layer.

If you do not plan to work on any other Exercise, close ArcMap.
Click No to discard all changes.

_& Save changes to Tutorial4.mxd?

If you do plan to work on other Exercise, then do a File New in
ArcMap and Click Yes to discard all changes to the current map
document.



Exercise 5: Finding the closest fire stations

In this Exercise you will find the closest four fire stations that can respond
to a fire at a given address. You will also generate the fastest route from
each of these fire stations that will be provided to each driver of the fire
engine.

Preparing your display

1.
2.

If you have Exercise5.mxd open in ArcMap, skip steps 2 to 5.

Start ArcMap by either double-clicking a shortcut installed on your
desktop or using the programs list in your Start menu. Choose Ok to
start ArcMap with new empty map.

Click File on the Main menu and click Open.

In the Open dialog box, navigate to C:\arcgis\ArcTutor\Network
Analyst\Exercise5S\ExerciseS.mxd. (This is the default install location
for this data.)

Double-click Exercise5.mxd.

If the Network Analyst Extension is not enabled, on the Tools menu,
click Extensions, and in the Extensions dialog, click Network Analyst
and close the Extensions dialog.

If the Network Analyst toolbar is not already present, on the Main
menu, click View, point to Toolbars, and click Network Analyst.

hetwodcanatee ]
Network Analyst = ||§\ B ‘NEIWUIKDa\aSEI e | B BN
If the Network Analyst Window is not already [etwork Analyst Window —E2)
open, click the Network Analyst Window button H
& on the Network Analyst toolbar.
This is a dockable window which you can dock
within the ArcMap window or leave undocked.
In this Exercise, the window is docked below the
Table of Contents.
e

Creating the Closest Facility analysis layer

1.

On the Network Analyst toolbar, click the Network Analyst
dropdown menu and click New Closest Facility.

The Network Analyst Window now contains an
empty list of Facilities, Incidents, Routes, and
Barriers categories.

Closest Facility b |14

Incidents (0)
Routes (0)
Barriers (0}

Additionally, the Table of Contents contains a new

Closest Facility analysis (group) layer. o r—
A Facites
® Eror
@ Locased
Adding facilities of
Next you will add facilities from a point file for which L ﬂ’u,;‘*';‘i""'
a layer file has been created. e
3 Locaned
1. Right-click Facilities (0) in the Network Analyst —
window and click Load Locations. @ povs
2. Select Fire_Station from the Load From dropdown list. Keep the
default settings.
3. Click OK.

40 fire stations are listed in the Network Analysis
window and are displayed as facilities on the map.
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Adding an incident

Next, you will find a street address (1202 Twin Peaks Blvd) and add it as

an incident for Closest Facility Analysis.

1. Click Incidents(0) on the Network Analyst Window to select it as the
feature layer to which you will add the street address as a network

location. _
Closest Faility

Facilities (40}

Routes (0)
Barriers (0)

2. Select Find from the Edit menu to bring up the Find Dialog

= Luercisesmxd - ArcHap - Arclnfo

| ete [ ywew pouert goiecton 1ock ponom el
] £dee ¥ Lindo Lood network: kcations from festure dass.

T ™ Eeds

D

3. Inthe Addresses tab, Select “SanFranStreets” from the Choose an

address locator dropdown list.

Facfines | Flaces Addheaiss | Aoua Locetions
Choose on eckiest oo |
[SarFranzamets jﬂ
Herw Ecarch
S eneen | I —
A

4. Enter “1202 Twin Peaks Blvd” in the text box labeled Street or
Intersection. SR 2%

Faatiras| Placos Adchescas | Anua Locations |
SarFranthieste
FerFrongiee =l |
Svestor Inersection: [1202 Twan Pasks Bhvd =|
Show Standurdizshon | [ Bhowal candidass
gt |
e

5.

6.

7.

Click Find. One location is found with that street address and is listed
as a row in the table in the Find Dialog.

T 2l
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ane obgect found A
Right-click the row and click “Add as Network Location”. This adds
the located address as an incident on the Network Analyst Window
and on the map.
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Closest Fadlity

Facilities (40)

Routes (0)
Barriers (D)

Close the Find Dialog.



Setting up the parameters for the analysis

Next, you will specify the parameters for your Closest Facility analysis.

1. Click the Closest Facility Properties Button next to Closest Facility
on the Network Analyst Window to bring up the Layer Properties

dialog.
g Closest Faciity >

Facilities (40)
=
11202 Twin Peaks Bivd
Routes (0)
Barriers (0)

2. Inthe Layer Properties dialog, click the Analysis Settings tab.
Click the Impedance dropdown arrow and click Minutes (Minutes).

4. Set the Default Cutoff value to 3. ArcGIS will search for fire stations
that are within three minutes of the fire. Any fire station outside of
three minutes drive time will be ignored.

5. Increase the Facilities to Find from 1 to 4. ArcGIS will attempt to
search for four fire stations from the fire site, within the three minute
cutoff. If there are only three fire stations within the three minute
cutoff, then the fourth fire station will not be found.

Under Travel From, select Facility (fire station) to Incident (fire).
Select Everywhere from the Allow U-Turns dropdown box.

Select True Shape from the Output Shape Type dropdown box.

O =2

Check the box labeled Ignore Invalid Locations. This will let you
find the best route using located stops. Stops that were not located on
the network will be ignored.

10. Check Oneway in the Restrictions list.

11. Click OK to EOT— 2

Gananed | Gioie| Souca Anehsis Btings | Acouristion | Nabwerk: Loceion |
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Run the process to identify the closest facility

1. Click the Solve button §# on the Network Analyst toolbar.

The routes appear in the Map and in the Route Category on the
Network Analyst Window. J(/ -

Note that only 2 fire stations were found to be closest to the fire
within the three minute cutoff. You can optionally, increase the cutoff
value to 4 minutes and see how many fire stations are found.

2. Click the Directions Window button & in the Network Analyst
Toolbar to generate directions for routes from each fire station.
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If you do not plan to work on any other Exercise, close ArcMap.
3. Click No to discard all changes. I x|

1 ! Save changes to Tutoriald.mxd?

Yes | No [: I Cancel |
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Exercise 6: Calculating service area and creating a OD Cost Matrix

In this Exercise you will create a series of polygons representing the
distance that can be reached from a facility within a specified amount

of time. These polygons are known as service area polygons. You will
calculate 3-, 5-, and 10-minute service area polygons for six warehouses
in Paris. You will also find out how many stores lie within each of these
service areas. You have to identify one warchouse that should be relocated
to better service the stores. Additionally, you will create an Origin-
Destination Cost Matrix for delivery of goods from the warehouses to all
the stores within a 10-minute drive time. Such a matrix is used as an input
for logistics, delivery, and routing analyses.

Preparing your display

If you have Exercise6.mxd open in ArcMap, skip steps 2 to 5.

2. Start ArcMap by either double-clicking a shortcut installed on your
desktop or using the programs list in your Start menu.Choose Ok to
start ArcMap with new empty map.

Click File on the Main menu and click Open.

4. In the Open dialog box, navigate to C:\arcgis\ArcTutor\Network
Analyst\Exercise6\Exercise6.mxd. (This is the default install location
for this data.)

Double-click Exercise6.mxd.

6. Ifthe Network Analyst Extension is not enabled, on the Tools menu,
click Extensions, and in the Extensions dialog, click Network Analyst
and close the Extensions dialog.

7. If the Network Analyst toolbar is not already present, on the Main
menu, click View, point to Toolbars, and click Network Analyst.

Network Analyst =

Network Analyst + ”@‘ B ‘NelwmkDalasal [oheeten =] B2 &

RS —
8. If the Network Analyst Window is not already 3
open, click the Show/Hide Network Analyst

Window button ’E on the Network Analyst toolbar.

This is a dockable window which you can dock
within the ArcMap window or leave undocked.
In this Exercise the window is docked below the
Table of Contents.

Creating the Service Area analysis layer

1. On the Network Analyst toolbar, click the Network Analyst
dropdown menu and click New Service Area.

Network Analyst

Network analyst » || Z8 | 5 2 B | Netwark Dataset [Farttet -] B

T MewRoute

New Closest Fadlity
New QD Cost Matrix
Options...

T |

The Network Analyst Window now contains
an empty list of Facilities, Barriers, Lines, and Tamers ()
Polygons categories. et

Additionally, the table of contents contains a new =gmm—————
Service Area analysis layer.

Adding facilities

i Palygons:
Next, you will add warehouses as facilities for which the service area
polygons will be generated.

1. Right-click Facilities (0) on the Network Analyst Window and select
Load Locations. Select Warehouses in the Load From dropdown list
and click OK.

oz

QEI

System\Metm_Statlnr\%
Systemietio_E rirances

Lacation Anal

.

Click the plus (+) sign next to Facilities (6) in the Network Analyst
Window to show the list of six facilities. The facilities are also visible
on the map. =

[service Area =l

(Warehouse #1
(DWarehouse #2
(@warehouse #3
@Warehouse #4
(J)Warehouse #5 [%
(@Wwarehouse #6

Rarriare fNY

23



24

Setting up the parameters for the analysis

Next, you will specify that your service area will be calculated based

on Drivetime (minutes). Three service area polygons will be calculated
for each facility, one at 3 minutes, one at 5 minutes, and another at 10
minutes. You will specify that the direction of travel will be from the
facility, not towards the facility, that no U-turns are allowed, and that one-
way restrictions must be followed.

1. In the Network Analyst Window, click the Service Area Properties
Button [El|to bring up the Layer Properties dialog box

2. Click the Analysis Settings tab.
Click the Impedance dropdown list and select Drivetime (Minutes).

Type “3 5 10” in the Default polygon breaks text box. (Enter this as 3
5 10, the three numbers are separated by a space, without the quotes.)

Ee

Under Direction, click Away from facility.
Click Nowhere from the Allow U-turns dropdown list.

Check Oneway in the Restrictions list to honor one way restrictions.

® =N

Check the Ignore Invalid Locations checkbox.
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9. Click the Polygon Generation tab.

10. Make sure that Generate Polygons is checked.

11. Click Generalized for Polygon Type. This results in faster analysis.
Detailed polygons are much more accurate, but need more time to be
generated.

12. Un-check the Trim Polygon option. This is post-process that trims the
outside polygon to remove spikes but takes a little longer to run.

13. Click Overlapping polygons per facility under Multiple Facilities
Options. This results in individual polygons per facility that may or
may not overlap.

14. Click Rings for the Overlap type. This excludes areas of smaller
breaks from the polygons of a bigger break.

15. Click Apply to save the settings.
v roenies TP
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16. Click the Line Generation tab.
17. Leave the box labeled Generate Lines unchecked. )
i L | Iwum‘f‘!]
£ b L-—l ol
18. Click OK to save
your settings.
Comel |tk




Run the process to compute the Service Area

1. Click the Solve button ﬁ on the Network Analyst toolbar.

The service area polygons appear on the map and on the Network
Analyst Window.

There is a transparency set by default for the Polygons layer. This
shows the underlying layers and gives an idea of the area under the

polygons with respect to the street network.
[ e

Identifying stores that do not lie within any polygon

1. In the table of contents select and move the Stores feature layer to the
top to improve visibility.

=] Service Area
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2.

Choose Select by Location from the Selection menu.
Selection Tools Window Help

from Stores that are completely within Polygons, as shown below.
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Click Apply. This will select all stores that lie within service area
polygons.
Click Close.

You want to select stores that are not within the service area
polygons, which is the inverse of the current selection. To get the
selection of stores that are not within the service area polygons, you
can switch the selection.

Right-click Stores in the Table of Contents, point to Selection and
choose Switch Selection.
H= =i
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7. The selection now shows the distribution of stores not contained in
any service area polygon. You use this selection to identify the area
to which you will relocate a warehouse. This area appears to be in the
center of the map.

8. Right-click Stores in the Table of Contents, point to Selection and
choose Clear Selected Features.
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Relocating the least accessible warehouse

1. Look at the service area polygons of Warehouse #2. There are
no stores that lie within the 3-, 5- or 10-minute service areas of
Warehouse #2. Hence, you will relocate Warehouse #2 to better
service the stores.

2. On the Network Analyst Window, select Warehouse #2 under
Facilities (6).

@warshouse #1

Oq
@'warehouse #3

3. Use the Select/Move Network Location Tool - to move Warehouse
#2 to the center of the map, as shown in the figure below.

e e

Run the process to compute the Service Area

1. Click the Solve button ﬁ on the Network Analyst toolbar.

The service area polygons appear on the map and on the Network
Analyst Window.

Identifying the service area polygon that each store lies
within

1. In the table of contents, right-click Stores feature layer, point to Joins
and Relates and select Join...
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F.EN' ] Open Attribute Table

._,% <& Zoom ToLayer Remove Jug(s) »

E  Ushle Scale Range > Relate...

€ UseSymbolLevels Remove Relate(s)  »

c Selection » |

Choose Join data from another layer based on spatial location

P
x|

Juin lets o append additional data ta this layer's attibute table so you can,
for example, symibclize the layers features usin this data

What da you want ta jain te this layer?

[Join data fiom anather layer based on spatiallocation =]

Join attrbutes fiom aable
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Select Polygons as the layer to join to this layer.

1. Choose the layer to join ta this layer. or load spatial data from disk:

=l &

Incident - Tour Eiffel and

W arehouses

Select the first radio button labeled “it falls inside” to add the
attributes of polygon to all points that fall inside the polygon.

Each point will be given all the attributes of the polygon that:
it falls inside.

If & point falls inside more than one polvgon [for example, because
the layer being joined containg overlapping palpgans| the
attributes of the first polygon found will be joined.

iz closest o it.

A, distance field is added showing how close the polygon is [in the
urits of the target layer]. & polpgon that the paint falls inside is
treated a3 being closest to the point (ie. 5 distance of 0]

Specify the output shapefile to save the result of the join as
StoreswithPoly.shp.

2, The result of the jain will b= saved inta a new laer.
Specity output shapefils of featurs class for this risw [ayer
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Click OK to perform the join.

Right-click the newly added StoreswithPoly feature layer and select
Open Attribute Table. Each row displays the name of the store and
polygon it falls under. You can use this table to generate other useful

categories such as the number of stores within 0-3 minute service
area of warehouses.
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8. Close the attribute table.

You can optionally export your facilities (including the one you
moved to a new location) as a feature class.

9. Right-click Facilities (6) on the Network Analyst Window and click
Export Data

10. In the Export dropdown list, click All features.

I1. Set the coordinate system to be used by choosing the third radio
button labeled “the feature dataset you export the data into”

12. Type “C:\arcgis\ArcTutor\Network Analyst\Exercise6\
NetworkAnalysis.mdb\AnalysisObjects\New Warchouses” as the
output feature class. You can choose another location and name for
the output if you do not want to write to the input database.
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13. Click OK.

14. Choose No when prompted to add the
feature class to the map. You will not
be using this feature class for the
remaining exercise.
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Optionally, you can create an Origin-Destination cost matrix for
deliveries from the new warehouses to each store. The results of this
matrix can be used to identify the stores that will be serviced by each
warehouse within a 10-minute drive time. Also, you would like to
find the total drive time from each warehouse to its stores.

Creating the OD Cost Matrix analysis layer

1.

Adding origins

In the table of contents, uncheck Service Area analysis layer and
StoreswithPoly to improve readibility of the map.

On the Network Analyst toolbar, click the Network Analyst

dropdown menu and click New OD Cost Matrix.
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The Network Analyst Window now contains an empty list of Origins,
Destinations, Lines, and Barriers categories.

IODCOStMatrIX i l

Destinations (0)
Lines (0]
Barriers (0)

Additionally, the table of contents contains a new OD Cost Matrix
analysis layer. -5
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You can use the facilities from Service Area Analysis (in the previous
section) as origins. If you have not completed the section on Service Area
Analysis, you can alternately use the Warehouses feature layer.

1.

Right-click Origins (0) on the Network Analyst Window and click
Load Locations.

Select ServiceArea\Facilities in the Load From dropdown list. (If you
did not complete the previous section on service area analysis, you
can use Warchouses instead. Note that your results will not resemble
the results in this exercise.)

Uncheck the Selected Features Only check.

Click Use Network Location Fields radio button under Location
Position. Using network location fields will allow ArcGIS to use

the located position of Service Area facilities to locate the origins
again. This is much faster than using search tolerance to locate them
again. (If you are loading Warchouses, you will need to click the use
Geometry radio button and set the Search Tolerance to 50 meters.)
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Cancel

Click OK.

The Network Analyst Window now shows six origins under the
Origins list and on the map.
Ezra— |

Destinations (o)
Lines (2}
Barriers (0]

Adding destinations

Next you will add the stores as destinations.

1.

Right-click Destinations (0) on the Network Analyst Window and
click Load Locations.
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2. Choose Stores in the Load From dropdown list.

Under Location Analysis Properties, for the property Name, select
the field “NOM” from the dropdown list. Since the field name is in
French, ArcGIS Network Analyst was unable to map the field name

automatically.
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4. Click OK.

The Network Analyst Window now lists 21
destinations under the Destinations list.

These destinations are also displayed on the map.

Setting up the parameters for the analysis

Next, you will specify that your OD Cost Matrix will be calculated based
on time (Drivetime).You will set a default cutoff value of 10 minutes and
will ensure that all destinations are found within the specified cut off.
Additionally, you will specify that U-turns are allowed everywhere and
the output Shape type should be a straight line. Since all these trips are
on roads, one-way restrictions must be followed. All invalid locations
(locations that were not located) will be ignored.

1. Click the ODCostMatrix Properties Button next to
ODCostMatrix on the Network Analyst Window.
=

oD Cost Matrix

@Warehouse #1

i\ orchenica #7
Click the Analysis Settings tab.
Click the Impedance dropdown list and click Drivetime (Minutes).

Input 10 in the Default Cutoff Value dropdown list. This will create
origin-destination paths from each warehouse to all stores that can be
reached within 10 minutes.

5. Select <All> from the Destinations to Find dropdown list.

6. Select Everywhere from the Allow U-turns dropdown list.

7. Select Straight Line from the Output Shape Type dropdown list.
8. Check Oneway in the Restrictions list.

9. Check Ignore Invalid Locations

10. Click OK save the parameters.

Caraes | Scasma A Stings | Acormdwen | Hetwr: Lacatrs |
“Sutir ~Fraszsan

I Imedance: [0 postre (M ies] = B Drewen

i DesMCunve T 5

N

| Ty [empaene =

= D ghepeTior  [Enaprina ]
o

[ ] ol |_ s ||

29



30

Run the process to create the OD Cost Matrix

1. Click the Solve button ﬁ on the Network Analyst toolbar.

The OD lines appear on the map. The number of lines in this tutorial
are 24. These may be different for you depending on where you
relocated Warehouse #2.

2. Turn on the Service Area Layer, and display the Lines on top of the
service areas of the warehouses.

Allocating stores to warehouses
Based on the OD Cost Matrix, you can now identify the stores that would

be served by each warehouse.

1. Right-click on Lines (24) on the Network Analyst Window and click
on Open Attribute Table to open the OD cost matrix.
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The Attributes of Lines represents the origin destination cost matrix
from each warehouse to stores within a 10 minute drive time in
Paris. The OriginID column contains IDs of warehouses. The
DestinationID column contains IDs of stores. The DestinationRank is
a rank assigned to each destination that is served by a store based on
the total drive time. For example, in the table below, for Warehouse
#1, DestinationID 23 has a rank of 1 and DestinationID 24 has a rank
of 2. This is because it takes less time to go from Warehouse #1 to
DestinationID 23. (This may be differerent for you, as your analysis
results are dependent on the source feature class of the origins and
destinations.)
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The OD cost matrix displays the stores serviced by each warehouse
along with the total drive time for each route. Some stores are within
a 10 minute accessibility zone of more than one warchouse and can
be served by any one of them. The OD cost matrix can also be used
as an input in logistics routing models, that use origin destination
matrices to allocate goods and services.

Exit ArcMap and do not save any changes to the Exercise6.mxd.



Exercise 7: Creating a model for route analysis

In this Exercise you will create a model for finding the fastest delivery
route connecting 21 stores in Paris.

Preparing your display

If you have Exercise7.mxd open in ArcMap, skip steps 2 to 7.

2. Start ArcMap by either double-clicking a shortcut installed on your
desktop or using the programs list in your Start menu.

If the Network Analyst Extension is not enabled, on the Tools menu,
click Extensions, and in the Extensions dialog, click Network Analyst
and close the Extensions dialog.

3. Click File on the Main menu and click Open.

4. In the Open dialog box, navigate to C:\arcgis\ArcTutor\Network
Analyst\Exercise7. (This is the default install location for this data.)

Double-click Exercise7.mxd.

If the Network Analyst toolbar is not already present, on the Main
menu, click View, point to Toolbars, and click Network Analyst.
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7. If the Network Analyst Window is not already s
open, click the Network Analyst Window button
[E® on the Network Analyst toolbar.

This is a dockable window which you can dock
within the ArcMap window or leave undocked.
In this exercise, the window is docked below the table of contents.

8. In the table of contents, check the check boxes by the Stores layer to
show it on the map.

9. In the table of contents, uncheck the check box by the Metro System
group layer to hide it on the map.

Creating the Model

1.

2.

On the dard toolbar, click the Show/Hide ArcToolbox Window
Button |48 to show the ArcToolbox Window.

Right-click ArcToolbox in the ArcToolbox window and select New
Toolbox. [ERTTEE——

e
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Name the newly added toolbox “NetworkModel”.

Right-click on NetworkModel toolbox, select New and then Model.
A new model appears in the NetworkModel toolbox and in the map
window. (reE—
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Creating the Route Layer in the model

Next you will create the route layer within the model. The workflow

for using Network Analyst in a model is the same as the workflow for
using Network Analyst in ArcMap. First, you create a route layer and
set properties. Next, you add the network locations (stops) to be used as
inputs. Last, you solve and display the results.

1. Select the Make Route Layer tool in the Analysis Toolset of the
Network Analyst Tools toolbox and drag it into the model.
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2. Double-click the Make Route Layer Tool in the model, to set its
properties.

3. Click the ParisNet as the Input Analysis Network in the dropdown
list.

4. In the Impedance attribute dropdown list, click Drivetime.

Check the Reoder stops to find optimal route checkbox.

In the Preserve ordering of stops dropdown list, click PRESERVE
BOTH @
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7. Click OK to continue. The Input analysis network is now added to
the model. The Make Route Layer tool becomes yellow in color and
the output layer becomes green. Click the Full Extent button El to

view the entire model.
Maki: Route '
Layer

Adding stops in the model
Next you will add the stores as stops by using the Add Locations tool.

1. Select the Add Locations tool in the Analysis toolset of the Network
Analysis toolbox and drag it into the model.
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2. Select the Stores feature layer in the table of contents and drag it into

the model to the left of the Add Locations tool.
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3. Select the Add Connection Tool _.—"_I and connect Stores to the Add
Locations tool.

Make Roule
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4. Using the Add Connection tool &, connect the output layer called
Route to the Add Locations tool. The Add Locations tool becomes
yellow in color.

Extent button to view the entire model.

@
S =S

Adding the solve function and finding the best route

Click the Autoiifout button ﬁl to arrange the model. Click the Full
£

1. Select the Solve tool in the Analysis toolset in the Network Analyst
toolbox and drag it into the model.
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Using the Add Connection tool T.—:l, connect the output layer called
Network Analyst Layer to the Solve tool. The Solve tool becomes
yellow in color and the output layer becomes green. Click the
AutoLayout button 2| to arrange the model. Also click the Full
Extent button EI to view the entire model.

Using the Select tool M right-click on the output layer of the Solve
tool (Network Analyst Layer) and click Add To Display. This will
add the final output to the map.
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Click on the Save button El to save the model.

From the Model menu, choose Run Entire Model to perform the

analysis.
Model Edit View Window Help
Run

'
m 2
Validate Entire Model !7

Save

Close the model to inspect the results. Click Yes, when prompted to
save the model.

A new Route layer is added to the map, the Network Analysis

33



34

window has all the stops and the resultant route. The route is also
displayed on the map.

To access the shortest path feature class for further analysis, link
the output of the model to a Select Data tool found in the Data
Management\General toolbox. Double-click the Select Data tool to
set it’s properties. Once the form comes up, change the Child Data
Element to Route.

Link the output of the Select Data tool to a CopyFeatures tool from
Data Management\Features toolbox. Double-Click on the Copy
Features tool and type in ¢:\temp\path.shp and close the form. Now
running the entire model will solve the path, select the route sub layer
and export it out as a shape file.

Right-click the Model in the NetworkModel toolbox and select
Delete. Click Yes to verify the deletion.
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Exit ArcMap and do not save any changes to the Exercise7.mxd.
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